
Downloadable Audiobooks 

FAQ, Guidelines, and Requirements 



OverDrive Downloadable Audiobooks 
Birmingham Public Library 

 
FAQ, Guidelines and Requirements, & Questions To Ask 

 

Page 2 of  26  

 

Table of Contents 

(CTRL + click item to go directly to page) 
 

Audiobooks Comparison Chart ........................................................................................................................ 4 

Sources / Links: .................................................................................................................................................. 5 
Audiobooks Comparison Chart ........................................................................................... 5 
OverDrive Downloadable Audiobook Help .................................................................................. 5 
NetLibrary Downloadable Audiobook Help ................................................................................. 5 
JCLC Downloadable Audiobook Wiki ............................................................................................ 5 

Things To Do........................................................................................................................................................ 5 

Questions To Ask ................................................................................................................................................ 5 

Common Problems ............................................................................................................................................. 5 
Common Patron Questions ............................................................................................................. 6 
How and Where ................................................................................................................................. 6 
Checkout and Download & Reserves ............................................................................................ 6 

Getting Started ................................................................................................................................................... 7 
What do I need to download an audiobook? .............................................................................. 7 
How can I get a copy of OverDrive Media Console? .................................................................. 7 
Will upgrading or uninstalling OverDrive Media Console cause my previously 
downloaded content to be deleted? ............................................................................................ 8 
What Windows Media Player Version do I have? ....................................................................... 9 
On what platforms does OverDrive Media Console run? ......................................................... 9 
What other software do I need in order to use OverDrive Media Console?........................ 9 
How can I get a copy of Windows® Media Player®? ................................................................. 9 

Checkout / Downloading................................................................................................................................. 10 
How do I check out an Audio Book title? .................................................................................. 10 
Once I have checked out an OverDrive Audio Book title, how do I download it? ........... 10 
How do I download an OverDrive Audio Book title using Firefox?...................................... 11 
How do I get to my titles after I've downloaded them?......................................................... 12 
I cannot find the title I downloaded. Can I download it again? ........................................... 12 
How do I listen to my audio book?.............................................................................................. 13 
I am only interested in one of the chapters of the audio book I downloaded. Can I just 
play that chapter? .......................................................................................................................... 13 
What happens to the title I downloaded once I've finished with it? .................................. 13 
Can I use the materials I check out from this site on multiple machines? ....................... 13 
Can I renew an audiobook? How? ............................................................................................... 14 

Reserving an Audiobook ................................................................................................................................. 14 
What happens when I place an item on hold? ......................................................................... 14 
How many items can I place on hold at the same time? ....................................................... 14 
Once a title that I have placed on hold becomes available for me to check out, how 
much time do I have to check out the title before my hold expires?................................ 14 
How do I cancel a hold?................................................................................................................. 14 

Transferring (to Portable Device / MP3) .................................................................................................... 15 
To which devices can I transfer OverDrive Audio Book titles? ............................................ 15 
Can I download and play an eAudiobook on a Mac? ............................................................... 15 



OverDrive Downloadable Audiobooks 
Birmingham Public Library 

 
FAQ, Guidelines and Requirements, & Questions To Ask 

 

Page 3 of  26  

Can I download and play an eAudiobook on an iPod? ............................................................ 15 
Can I use OverDrive Audio Book titles with my Palm device?.............................................. 15 
How much free disk space do I need to have in order to transfer audio book titles to 
my portable device?....................................................................................................................... 16 
How do I transfer an audio book to my portable device? ..................................................... 16 

Burning To CD ................................................................................................................................................... 19 
Why can some titles be burned to CD but others cannot?.................................................... 19 
How can I tell if a title can be burned to CD? .......................................................................... 19 
How do I burn an audio book to CD using Windows Media Player 9? ................................. 20 

Licensing / Security ......................................................................................................................................... 21 
What are licenses and why do I need them? ............................................................................ 21 
What is a 'Windows Media Player Security Upgrade' and will I have to do it? ................. 21 

General ............................................................................................................................................................... 23 
Why doesn't the eAudiobook download, even though I get an acquiring license 
message? ........................................................................................................................................... 23 
Why won't the eAudiobook play on my portable listening device? It played just fine 
yesterday.......................................................................................................................................... 23 
Are audiobook files automatically removed from my computer when the checkout 
period expires?................................................................................................................................ 23 
What if my download does not complete successfully?......................................................... 23 
When I click on "Check Out & Download CD Quality" or "Check Out & Download Radio 
Quality" to download an eAudiobook I receive a C00D11CD, C00D1197 error or IE Web 
browser crashes.............................................................................................................................. 23 
Why did I get this message: "eAudiobooks: The Link You Clicked is No Longer Valid? (or 
something similar for OverDrive)" .............................................................................................. 24 
How long does it take to download an eAudiobook?.............................................................. 25 

Terms / ”What is…?” ....................................................................................................................................... 25 
What is an OverDrive Audio Book title? .................................................................................... 25 
What is the OverDrive Media Console™? ................................................................................... 25 
What is a 'bit rate'?......................................................................................................................... 25 

Index ................................................................................................................................................................... 26 
 



OverDrive Downloadable Audiobooks 
Birmingham Public Library 

 
FAQ, Guidelines and Requirements, & Questions To Ask 

 

Page 4 of  26  

 

Audiobooks Comparison Chart 

  JCLC Downloadable 
Collection (Overdrive) 

JCLC eAudiobooks 
(NetLibrary) 

Number of Titles 512 and growing 1,409 with 30 added per 
month 

Fiction and Non-
Fiction 

Yes/Yes Yes/Yes 

Titles in Library’s 
Web Catalog 

Yes Yes 

Loan Period 14 Days, cannot be 
checked back in before the 
full checkout period 

21 Days, cannot be 
checked back in before the 
full checkout period 

Software Required OverDrive Media Console  

Windows Media Player 9 or 
higher 

Windows Media Player 9 or 
higher 

Maximum titles 
checked out at one 
time 

5 10 

Place Holds Yes No need; unlimited copies 
available 

Automatic Check-In Yes Yes 

Download to MP3 
players* 

Yes Yes, but only in CD-quality 
format 

Burn to CD Most titles No 

Renewable Yes Yes 

How to Sign-up for an 
Account 

No account needed. Use 
your name and library card 
barcode number to 
checkout audiobooks. 

Create a free NetLibrary 
account here. Follow the 
directions on the form. 
Once you have signed up 
for your account, you can 
use it anywhere. 

Online Help Yes  Yes 
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Sources / Links: 

Audiobooks Comparison Chart  
http://www.bplonline.org/virtual/ebooks.asp 

 
OverDrive Downloadable Audiobook Help 

http://downloadable.jclc.org/1E409489-852C-4B3C-AB3F-CB7D5E6FF17F/10/241/en/Help.htm 
 

NetLibrary Downloadable Audiobook Help 
http://0-www.netlibrary.com.vulcan.bham.lib.al.us/Help/Default.aspx 
 
JCLC Downloadable Audiobook Wiki 
http://jclcdownloadables.pbwiki.com/ 
 
 

Things To Do 
 

1 Verify all conditions/restrictions/questions at 
a. http://www.bplonline.org/virtual/ebooks.asp AND 
b. OverDrive - http://downloadable.jclc.org/1E409489-852C-4B3C-

AB3F-CB7D5E6FF17F/10/241/en/Help.htm 
c. NetLibrary - http://0-

www.netlibrary.com.vulcan.bham.lib.al.us/Help/Default.aspx 
2 Check validity of library card. 
3 If MP3 download problem, verify valid device via bottom of above 

website. 
4 Check Downloadable Audiobook Wiki 

(http://jclcdownloadables.pbwiki.com/) 
5 Determine nature of problem.  See “Table of Contents“ for types of 

problems. 
 
 

Questions To Ask 
 

1 Is the problem with OverDrive or NetLibrary? 
2 How many downloadable audiobooks do you have checked out? 
3 Have you had the problem before? 
4 What version of Windows Media Player do you have? 
5 What web browser are you using? 

 

 
Common Problems 

See “Downloadable Audiobook Wiki – (http://jclcdownloadables.pbwiki.com/) 
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Common Patron Questions 

 
� What do I need to download audiobooks? 

o OverDrive - OverDrive Media Console & latest Windows Media Player (9 
or higher) 

� How do I create an account? 
o OverDrive - No account needed. Use your name and library card barcode 
number to checkout audiobooks. 

http://0-www.netlibrary.com.vulcan.bham.lib.al.us/CreateAccount.aspx. 
� How long can I have a downloadable audiobook checked out? 

o OverDrive – 14 days  
� How many titles can I have checked out a 1 time? 

o OverDrive – 5  
� Can I reserve a downloadable audiobook? 

o OverDrive – Yes  
� How are downloadable audiobooks checked in? 
     They cannot be checked back in before the full checkout period. 

� Can I checkin a downloadable audiobook when I’m finished with it? 
                No.  Checkin is automatic after the checkout expires. 

� Can I burn a downloadable audiobook to a CD? 
o OverDrive – Most titles; check the specific title 

� Can I load a downloadable audiobook to my MP3 player? 
o OverDrive – Yes  

 
How and Where 

 
� How do I get started? 
� How do I get a copy of the OverDrive software? 
� How do I get Windows Media Player? 
� What are the system requirements? 
� Which MP3 players can I use? 
� Where can I get more information? 

 
 
 Checkout and Download & Reserves 

 
� How do I checkout a title? 
� How do I download a title? 
� How do I reserve a title? 
� How do I access the title I downloaded? 
� Can I download a title more than once?  How? 
� Can I use the materials I check out from this site on multiple machines? 
� How do I transfer an audio book to my portable device?  
� How do I burn an audio book to CD (using Windows Media Player)? 
� Do I need a special license? 
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Getting Started  
(see  
http://downloadable.jclc.org/1E409489-852C-4B3C-AB3F-CB7D5E6FF17F/10/241/en/Help-

QuickStartGuide.htm) 
 

What do I need to download an audiobook? 

• A valid library card  
• Access to the Internet  
• A copy of OverDrive Media Console (free download) 

How can I get a copy of OverDrive Media Console? 

System Requirements 

• Operating system:  
o Microsoft® Windows 98 Second Edition (SE), Windows 2000 

(Professional or Server), Windows Millennium Edition (ME), 
Microsoft Windows XP (Home, Professional, Tablet PC, or 
Media Center Edition), Windows Vista (Home, Basic, Home 
Premium, Business, or Ultimate Edition). 

• Processor:  
o A 233 megahertz (MHz) processor, such as an Intel Pentium II 

or Advanced Micro Devices (AMD) processor 
• RAM:  

o 64 megabytes (MB) 
• Free hard disk space:  

o 100 MB 
• Sound card:  

o 16-bit sound card 
• Video adapter and monitor:  

o Super VGA (800 x 600) or higher resolution 
• Browser:  

� OverDrive 
� Microsoft Internet Explorer 5.01 (or newer) 
� Firefox 1.x 

� NetLibrary 

� Internet Explorer 5.5 and above  

� Netscape 6.2 and above  

� Mozilla 1.1 and above  

� Firefox 1.0 and above  

� Opera 7.0 and above 

• Windows Media Player 9 Series (or newer)  
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Download and installation of the free OverDrive Media Console:  

1. Go to the OverDrive Media Console download page 
(http://www.overdrive.com/MediaConsole/download.asp). 

2.  At the OverDrive Media Console download page, click the 'OverDrive 
Media Console' link to start the download process. 
A 'File Download' box is displayed.  

3. Select option 'Save' or 'Save this program to disk'. Browse to (and make 
note of) a location to save the file, and click the 'OK' button to 
download the OverDrive Media Console install file 
(ODMediaConsoleSetup.exe) to your machine.  
Please be patient, as this may take a few minutes to download and 
save.  

4. If you are using IE 5.0 or higher, a dialog box may be displayed when the 
download is complete. Click the 'Open' button to begin the installation. 
Otherwise, locate the '.exe' file (ODMediaConsoleSetup.exe), and 
double-click it to begin installation. Note that upgrading or uninstalling 
OverDrive Media Console will not affect any content that you have 
previously downloaded; all items in your 'Media Library' will be 
maintained through either process. 
The 'OverDrive Media Console Setup Wizard' is displayed.  

5. Click the 'Next >' button to begin the installation process. 
The 'Software License Agreement' screen is displayed.  

6. Review the 'Software License Agreement', and select the 'I Agree' option 
(if you agree). Then, click the 'Next >' button. 
The 'Select Installation Folder' screen is displayed.  

7. At the 'Select Installation Folder' screen, either browse to the location 
to which you would like to save the program, or leave the default 
location. Also, indicate whether you would like the program to be 
accessible to 'Everyone' or 'Just me', then click the 'Next >' button. 
The 'Confirm Installation' screen is displayed.  

8. Click the 'Next >' button to start installation. 
When the installation is complete, the 'Installation Complete' window is 
displayed.  

9. Click the 'Close' button to exit the wizard.  

10. Once the installation is complete, you may delete the install file 
(ODMediaConsoleSetup.exe).  

Will upgrading or uninstalling OverDrive Media Console cause my previously 
downloaded content to be deleted? 

Upgrading or uninstalling OverDrive Media Console will not affect any content 
that you have previously downloaded; all items in your 'Media Library' will be 
maintained through either process.  
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What Windows Media Player Version do I have? 

There are two ways you can determine which version of Windows Media Player 
you have installed:  

1. Press the F1 key anywhere on the Windows Media Player window. The 

version displays.  

2. Press the Alt key anywhere on the Windows Media Player window. The 

standard menu bar displays. Click on Help and About Windows Media Player. 

The version displays. 

On what platforms does OverDrive Media Console run? 

OverDrive Media Console supports the following platforms: 

• Microsoft Windows 98 Second Edition (SE)  
• Microsoft Windows Millennium Edition (ME)  
• Microsoft Windows 2000 (Professional or Server®)  
• Microsoft Windows XP (Professional, Home, Tablet PC, or Media Center 

Edition)  
• Microsoft Windows Vista (Home Basic, Home Premium, Business, or 

Ultimate Edition)  

What other software do I need in order to use OverDrive Media Console? 

To use OverDrive Media Console, you will need to have Windows Media Player 
(9 Series or newer) installed on your PC. 

How can I get a copy of Windows® Media Player®? 

Microsoft Windows Media Player is a free download.  Go to 
http://www.microsoft.com/windows/windowsmedia/download/AllDownloads.a
spx?displang=en&qstechnology= to review system requirements and download 
Windows Media Player. Note that Windows Media Player 9 Series or newer is 
required in order to use OverDrive Media Console.  

 

 
 
 
 
 
 
 



OverDrive Downloadable Audiobooks 
Birmingham Public Library 

 
FAQ, Guidelines and Requirements, & Questions To Ask 

 

Page 10 of  26  

Checkout / Downloading 

How do I check out an Audio Book title? 

You can browse or search the library website for downloadable materials. 
When you locate a title of interest, simply add it to your cart and check out the 
title.  

If a desired title is not available, you may place a hold on the title.  

Once you have checked out a title, a download page will be displayed. Click 
the 'Download' link to start the download. Once the download is complete, you 
can close your Internet connection and enjoy the materials offline. 

You will never accrue late fees with titles you download from the library 
website. At the end of the loan period, titles will expire and be automatically 
'returned' to the library. At this time, you can delete the expired file(s) from 
your machine. 

Once I have checked out an OverDrive Audio Book title, how do I download 
it? 

1. After the book has been checked out, click on the 'Download' button 
next to the cover image of the book. 
OverDrive Media Console opens and the 'Get Media' dialog box prompts 
for the folder to which the file(s) should be downloaded.  

2. In the OverDrive Media Console 'Get Media' dialog box, specify a 
download location (or leave the default file path) then click the 'OK' 
button. 
The 'Download Part(s)' dialog box is displayed.  

3. In the 'Download Part(s)' dialog box, choose which part(s) you would like 
to download by placing a checkmark next to the desired part(s), then 
click the 'OK' button.  
The 'Download Part(s)' dialog box closes, and the file download begins. 
Download progress is displayed for each part in the OverDrive Media 
Console Status Bar (when enabled, the status bar is displayed across the 
bottom of the OverDrive Media Console window).  
When the download is complete, click the 'Play' button to play the title.  

The license for the audio title can be downloaded three times from this 
website. Please note that this restriction only applies to downloading the 
license from the library website. After you have downloaded the license, you 
may download the audio files as needed using OverDrive Media Console. 
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How do I download an OverDrive Audio Book title using Firefox? 

If you are using Firefox, after the title has been checked out, click on the 
'Download' button next to the cover image of the title. If prompted, choose 
option 'Open with', and browse to 'OverDrive Media Console'. To adjust your 
settings so that you do not have to repeat this step going forward, check the 
box next to 'Do this automatically for files like this from now on'. 

If you have already downloaded a file with Firefox and are unable to open it, 
complete the following steps:  

If you have Firefox 1.x… 

1. Open Firefox.  
2. Go to Tools > Options. 

The 'Options' dialog box is displayed.  
3. In the 'Options' dialog box, click the 'Downloads' button.  
4. Under the heading 'File Types', select either 'ODM OverDrive.Media' or 

'application/x-od-media' (the option you will see will vary depending on 
the version of Firefox you are using) and click the 'Change action' 
button. 
The 'Change Action' dialog box is displayed.  

5. Select 'Open them in this application'. 
The 'Choose Application' dialog box is displayed.  

6. Browse to 'OverDrive Media Console' and double-click 'OverDrive Media 
Console'. 
The 'Choose Application' dialog box is closed, displaying the 'Change 
Action' dialog box again.  

7. Click the 'OK' button to save your change. 
The 'Change Action' dialog box is closed, displaying the 'Options' dialog 
box again.  

8. Click 'OK' to exit the 'Options' dialog box.  
9. Be sure you are connected to the Internet, then browse to the file you 

were unable to open. Double-click the file.  
OverDrive Media Console launches, allowing you to use your audio book 
file.  

Please note that the initial download is a small file; you download the actual 
audio book file(s) from within the OverDrive Media Console application. 

If you have Firefox 2.x… 

1. Open Firefox.  
2. Go to Tools > Options.  

The 'Options' dialog box is displayed.  
3. Select 'Content'.  

The 'Content' options are displayed.  
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4. Under the 'File Types' heading, click the 'Manage…' button.  
The 'Download Actions' dialog box is displayed.  

5. Select the 'ODM' file extension and click the 'Change Action' button.  
The 'Change Action' dialog box is displayed.  

6. Select option 'Open them with this application'.  
The 'Select Helper Application' dialog box is displayed.  

7. In the 'Select Helper Application' dialog box, navigate to the location at 
which OverDrive Media Console is installed (by default the application is 
installed to C:\Program Files\OverDrive Media Console) and select 
'MediaConsole.exe'.  

8. Click 'Open' in the 'Select Helper Application' dialog box.  
The 'Select Helper Application' dialog box closes.  

9. Click 'OK' in the 'Change Action' dialog box.  
10. Click 'Close' in the 'Download Actions' dialog box.  
11. Click 'OK' to exit the 'Options' dialog box.  
12. Be sure you are connected to the Internet, and browse to the file you 

were unable to open. Double-click the file.  
OverDrive Media Console launches, allowing you to use your audio book 
file(s).  

Please note that the initial download is a small file; you download the actual 
audio book file(s) from within the OverDrive Media Console application. 

How do I get to my titles after I've downloaded them? 

Access downloaded titles as follows: 
 
OverDrive Media Console automatically saves a copy of the audio book to your 
computer.  To play an audio book, open OverDrive Media Console and select 
the desired title from the 'Media Library'. 
 
Note that if you've misplaced your copy of a downloaded title, the Jefferson 
County Library Cooperative maintains a history of borrowed digital materials 
called 'My Bookshelf'. During the lending period, most digital materials can be 
re-downloaded from the My Bookshelf feature by clicking on the 'My Bookshelf' 
link in the My Downloadable Account section.  

I cannot find the title I downloaded. Can I download it again? 

If you've misplaced your copy of a downloaded title, Jefferson County Library 
Cooperative maintains a history of borrowed digital materials called 'My 
Bookshelf'. During the lending period, you can re-download from the My 
Bookshelf feature by clicking on the 'My Bookshelf' link in the My Downloadable 
Account section. To reach the My Downloadable Account section, click the 'My 
Downloadable Account' link and enter the required login information.  
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How do I listen to my audio book? 

When the book has finished downloading, click the 'Play' button in OverDrive 
Media Console. The 'OverDrive Media ™' window is displayed and the file begins 
playing. 

If desired, you can navigate directly to a desired section of the audio book. For 
ease of download and use, many OverDrive media titles are divided into Parts, 
and Parts are then divided into logical sections (such as chapters for audio 
books). The beginning points of these logical sections are MediaMarkers. Click 
on the desired Part to display associated MediaMarkers. Click the desired 
MediaMarker to start play at that point in the file. 

I am only interested in one of the chapters of the audio book I downloaded. 
Can I just play that chapter? 

You can navigate directly to a desired point in a title using 'Parts' and 
'MediaMarkers'. For ease of download and use, many OverDrive media titles are 
divided into Parts, and Parts are then divided into logical sections (such as 
chapters for audio books). The beginning points of these logical sections are 
MediaMarkers. 

To display Parts and MediaMarkers in OverDrive Media Console, click the 'Play' 
button. The 'OverDrive Media  window is displayed and the file begins playing. 
Parts are displayed on the left-hand side of the window, and the MediaMarkers 
for the selected Part are displayed on the right-hand side of the window. 

Click on the desired Part to display associated MediaMarkers. Click the desired 
MediaMarker to start play at that point in the file. 

What happens to the title I downloaded once I've finished with it? 

Downloaded files remain on your computer (even after they have expired) until 
you manually delete them. Please review these instructions for deleting 
expired files: 

To delete an expired audio book file... 

1. Open OverDrive Media Console.  
2. Locate the audio book you wish to delete in the 'Media Library'. Single-

click on the title to select it, then click the 'Delete' button.  

Can I use the materials I check out from this site on multiple machines? 

Yes.   OverDrive Audio Books can be downloaded to multiple computers, 
transferred to supported portable devices, and burned to CD (when allowed by 
the publisher). 
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Can I renew an audiobook? How? 

OverDrive items cannot be renewed, but you can check them out again if they 
are available when your checkout expires.  

If you want to check out an OverDrive Media Console title again... 
When you check out the title a second time, the license is reactivated. Click 
the 'Download' button at this website to download a new license. You do not 
need to download the actual media files a second time. 

 

Reserving an Audiobook 

What happens when I place an item on hold? 

The title you have placed on hold will be reserved for you to check out once it 
becomes available. When the title is available for you, you will receive an 
email with instructions on checking the book out. The item will be held for you 
for 2 day (starting when you are emailed notice that the title is available). 

How many items can I place on hold at the same time? 

You can place up to 5 titles on hold at a given time.  

Once a title that I have placed on hold becomes available for me to check 
out, how much time do I have to check out the title before my hold expires? 

Once the title you have placed on hold becomes available for check out, you 
will receive an email indicating the title is available. If 2 day elapses from the 
time you are emailed this notice, and you have yet to check out the title, the 
title is returned to the library collection, making it available to other patrons 
at your library.  

How do I cancel a hold? 

To cancel a hold, please take the following steps:  

1. From any page, choose the 'My Downloadable Account' button.  
2. Log in to your account.  
3. Click the 'My Reserves' link. 

The list of titles that you have currently placed on hold is displayed.  
4. Click the 'Remove' link next to the title in which you are no longer 

interested. 
This action cancels your hold.  
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Transferring (to Portable Device / MP3) 

To which devices can I transfer OverDrive Audio Book titles? 

To review a suggested list of portable devices, click for OverDrive. 

 Note that in order to use OverDrive Audio Book titles on a device, the device 
must play DRM-protected Windows Media content, and either support the bit 
rate of 32kbps or be able to transcode 32kbps files to a supported bit rate.  
 
You may want to check device documentation to determine if a device supports 
DRM-protected Windows Media content at 32kbps. 
 
If you are using a Pocket PC, OverDrive Media files must be transferred to a 
memory card. Be sure you have a memory card with sufficient memory space 
installed, and be sure to specify the memory card in the course of the transfer 
process. 

Can I download and play an eAudiobook on a Mac?  

 
 No. audiobooks cannot be played on Macs because the latest version of 
Window Media Player available for Macs (version 9) is based on Windows Media 
Rights Manager version 1.3. We use version 2.x licenses for downloadable 
audiobooks in order to maintain a high level of security. 

Can I download and play an eAudiobook on an iPod?  

 
No. audiobooks cannot be played on iPods. iPods use the .aac file format and 
the .aac file format does not support the Digital Rights Management (DRM) 
protection required by our audiobooks at this time. DRM protection helps 
ensure that the content of our publishing partners is secure, especially when 
items are checked out from the library's collection and borrowed by a user 
rather than purchased. This Digital Rights Management technology allows 
checked out items to expire on the due date. 

Can I use OverDrive Audio Book titles with my Palm device? 

OverDrive Audio Book titles may be transferred to certain Palm devices with 
the help of a third party application called Pocket Tunes. For a list of 
supported Palm devices, see the Pocket Tunes website at http://www.pocket-
tunes.com. For instructions on installing and using Pocket Tunes with OverDrive 
Audio Book titles, please see 
http://www.overdrive.com/deviceresourcecenter/pockettunes.asp. 
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Please note that Pocket Tunes is not a free application. For more information 
on purchasing Pocket Tunes, see the Pocket Tunes website at 
http://www.pocket-tunes.com. 

How much free disk space do I need to have in order to transfer audio book 
titles to my portable device? 

Audio book titles for OverDrive Media Console are delivered in parts, with each 
part generally not exceeding 18MB in size. As long as your portable device has 
at least 18MB of storage space you should be able to transfer a single part or 
more to it at a time. 

Note that if you are using OverDrive Media Console v2.1, the Transfer Wizard 
will alert you if you do not have enough storage space on your device to 
accommodate the files that you are attempting to transfer. The Transfer 
Wizard allows you to delete files that are on your portable player in order to 
make room for the files you wish to transfer. 

How do I transfer an audio book to my portable device? 

If you are using OverDrive Media Console v2.1… 

1. Connect your portable player to your computer.  
2. In OverDrive Media Console, highlight the title you wish to transfer and 

click the 'Transfer' button.  
The OverDrive Media Console Transfer Wizard is displayed.  

3. Verify that the correct title is displayed on the first screen of the 
Transfer Wizard and click 'Next'.  
The Transfer Wizard will search for a connected portable device.  
If your device is detected the 'Confirm' screen is displayed.  
If your device is not detected, the Transfer Wizard will display a 
message stating that 'no portable players could be found.' Click here for 
more information about why your portable player could not be found.  

4. In the 'Confirm' dialog box, select the part(s) you want to transfer by 
checking the box(es) next to the part name(s).  

5. Click 'Next' to begin transferring the file(s) to your device.  
When the file transfer is complete, the Transfer Wizard displays a 
'success' message.  

6. Click 'Finish' to exit the Transfer Wizard.  
You may now disconnect your portable device and enjoy your title.  

Note: If you are using a Pocket PC, OverDrive Media files must be 
transferred to a memory card. Be sure you have a memory card with 
sufficient memory space installed, and be sure to specify the memory card 
in the course of the transfer process. 
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To review a suggested list of portable devices, click here. To use 
OverDrive Audio Books on a device, the device must either support the bit 
rate of 32kbps or be able to transcode 32kbps files to a supported bit rate.  

If you are using OverDrive Media Console v1.x or 2.0 and Windows Media Player 
9… 

*Transferring files to a portable device is greatly simplified with the 
use of OverDrive Media Console v2.1. To review system requirements 
and download the latest version of OverDrive Media Console, click 
here. 

1. In OverDrive Media Console, highlight a book and click the 
'Transfer/burn' button.  
Windows Media Player opens.  

2. Turn off skin mode, if necessary, and click the 'Copy to CD or Device' 
button.  
The 'Copy to CD or Device' screen will appear.  

3. Select the part(s) you want transferred to the portable device by 
checking the box(es) next to the part name(s).  

4. Connect your portable media device and ensure that it is selected in the 
right hand pane of Windows Media Player.  

5. Click the 'Copy' button in the upper right hand corner of Windows Media 
Player to copy the part(s) to the portable device.  
Windows Media Player will inspect and copy the file(s) to the device. 
This process should take less than a minute, depending on how many 
files you transfer. You may follow the Player's progress by monitoring 
the 'Status' field in Windows Media Player.  

6. When the transfer is complete, the status field in Windows Media Player 
will indicate 'Complete'.  
You may now disconnect your portable device and enjoy your OverDrive 
Audio Book title.  

Note: If you are using a Pocket PC, OverDrive Media files must be 
transferred to a memory card. Be sure you have a memory card with 
sufficient memory space installed, and be sure to specify the memory card 
in the course of the transfer process. 

If you are using OverDrive Media Console v1.x or 2.0 and Windows Media Player 
10… 

*Transferring files to a portable device is greatly simplified with the 
use of OverDrive Media Console v2.1. To review system requirements 
and download the latest version of OverDrive Media Console, click 
here. 
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1. In OverDrive Media Console, highlight your book and click the 
'Transfer/burn' button.  
Windows Media Player opens and begins playing the title.  

2. You may stop playback at this point if you choose. Click the 'Library' 
tab.  
The Media Library will be displayed but the 'Now Playing List' should 
remain.  

3. Do one of the following:  
 
If you wish to transfer all parts, ensure that your portable device is 
connected and click the 'Start Sync' button.  
Windows Media Player will transfer the files to your device in the order 
that they appear in the 'Now Playing List'.  
 
If you wish to transfer a specific part(s) to your device, you can remove 
parts from the Sync List. Click on the unwanted parts and press the 
'Delete' key. Alternatively, you can right-click an unwanted part and 
select 'Remove from List' from the menu. When the Sync List is ready, 
ensure that your device is connected and click the 'Start Sync' button.  
Windows Media Player begins to transfer the files to your device in the 
order that they appear in the 'Now Playing List'.  
 
This process may take a few minutes. You can follow the Player's 
progress by monitoring the 'Status' field next to the part name in the 
Sync List.  

4. When the transfer is complete, the status field will indicate 'Complete'.  
You can now disconnect your portable device and enjoy your OverDrive 
Audio Book title.  

Note: If you are using a Pocket PC, OverDrive Media files must be 
transferred to a memory card. Be sure you have a memory card with 
sufficient memory space installed, and be sure to specify the memory card 
in the course of the transfer process. 

If you are using OverDrive Media Console v1.x or 2.0 and Windows Media Player 
11… 

*Transferring files to a portable device is greatly simplified with the 
use of OverDrive Media Console v2.1. To review system requirements 
and download the latest version of OverDrive Media Console, click 
here. 

1. In OverDrive Media Console, highlight your title and click the 
'Transfer/burn' button. 
Windows Media Player opens and begins playing the title; do not stop 
playback.  

2. Click the 'Sync' tab.  
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3. Select the 'Now Playing' list under the 'Playlists' heading on the left side 
of Windows Media Player.  

4. Select the parts you wish to transfer and drag them to the Sync list on 
the right side of Windows Media Player. 
When the Sync List is ready, ensure that your device is connected and 
click the 'Start Sync' button. 
Windows Media Player begins to transfer the files to your device in the 
order that they appear in the 'Sync List'. 
This process may take a few minutes. You can follow the Player's 
progress by monitoring the 'Status' field next to the part name in the 
Sync List.  

5. When the transfer is complete, the status field will indicate 'Complete'. 
You can now disconnect your portable device and enjoy your title.  

Note: If you are using a Pocket PC, OverDrive Media files must be 
transferred to a memory card. Be sure you have a memory card with 
sufficient memory space installed, and be sure to specify the memory card 
in the course of the transfer process. 

 
Burning To CD 
 

Why can some titles be burned to CD but others cannot? 

The publisher of each title decides whether or not to allow the title to be 
burned to CD; this decision is at the publisher's discretion. Many publishers 
enable this functionality while others choose not to permit this use of their 
content.  

How can I tell if a title can be burned to CD? 

There are two places you can check to see if a title may be burned to CD. You 
can check at this website or, if you have already checked out the title, you can 
look in OverDrive Media Console. 

At this website, check whether a title may be burned to CD as follows… 

Search for the desired title, and click the title to bring up the page displaying 
details about the title. At this page, look for the heading 'Digital Rights 
Information'. The information listed here will clearly indicate whether or not 
the publisher has enabled the burn to CD functionality. 

In OverDrive Media Console, check whether a title that you have already 
checked out may be burned to CD as follows… 
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1. In OverDrive Media Console, highlight the desired title and click the 
'Properties' button. 
The 'Properties' dialog box is displayed.  

2. Click the 'License' tab. (Note that if a 'License' tab is not displayed, the 
title is not digitally protected and can be burned to CD.) 
'License details' for the selected title are displayed, indicating whether 
or not the title may be burned to CD.  

3. Click the 'Cancel' button to close the 'Properties' dialog box.  

How do I burn an audio book to CD using Windows Media Player 9? 

1. If you have not already done so, verify that the permissions on the title 
allow you to burn the file to CD (publishers may opt to disable this 
functionality):  

a. In OverDrive Media Console, highlight the desired title and click 
the 'Properties' button.  
The 'Properties' dialog box is displayed.  

b. Click the 'License' tab. (Note that if a 'License' tab is not 
displayed, the title is not digitally protected and can be burned 
to CD.)  
'License details' for the selected title are displayed, indicating 
whether or not the title may be burned to CD.  

c. Click the 'Cancel' button to close the 'Properties' dialog box.  
2. In OverDrive Media Console, highlight the desired title and click the 

'Burn' button, or choose menu option File > Burn. 
Windows Media Player opens and begins playing the title; you can stop 
playback at this point if you choose.  

3. Turn off skin mode, if necessary, and click the 'Copy to CD or Device' 
button. 
The 'Copy to CD or Device' screen is displayed.  

4. Select the part(s) you want to burn to CD by checking the box(es) next 
to the part name(s).  

5. Place a blank CDR in your CD-ROM drive and ensure that your CD drive is 
selected in the right- hand pane of Windows Media Player.  

6. Click the 'Copy' button in the upper right-hand corner of Windows Media 
Player to add the part(s) to the list of files to be burned to disc. 
Windows Media Player inspects, converts, and temporarily copies the 
file in preparation for burning. This process may take a few minutes. 
You can follow the Player's progress by monitoring the 'Status' field in 
Windows Media Player.  
When the burning process is complete, the status field indicates 
'Complete'.  

7. You can now eject the disc and enjoy your title on CD.  
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Licensing / Security 

What are licenses and why do I need them? 

Licenses are files that allow DRM-protected content to be played with Windows 
Media Player. Before Windows Media Player will open a DRM-protected file, it 
verifies that the user has the appropriate license. If the user does not have a 
license for the content, the file will not open. Licenses are automatically 
managed by OverDrive Media Console when audio books are downloaded. 

What is a 'Windows Media Player Security Upgrade' and will I have to do it? 

The Windows Media Security Upgrade is a process that must be performed 
before Microsoft Windows Media Player will allow any DRM-protected files to be 
played. A security measure, the security update identifies the copy of Windows 
Media Player with the computer on which the Player is being used. Publishers 
often require this sort of security in order to discourage the unlawful 
redistribution of digital content. 

If you have not previously performed the security upgrade, the first time that 
you open OverDrive Media Console, OverDrive Media Console checks to see if 
you need to complete the security upgrade. If a security upgrade is needed, a 
message is displayed notifying you that in order to play DRM-protected content, 
you must first upgrade the security of your Windows Media Player. Follow the 
instructions provided in the message to complete the security update. 

Alternatively, you may complete the security upgrade at any time. Complete 
the security upgrade as follows… 

If you have Windows Media Player 9 or 10… 

1. While connected to the Internet, open OverDrive Media Console.  
2. Go to Tools > Windows Media Player Security Upgrade. 

A dialog box is displayed, notifying you that your Windows Media Player 
requires a security upgrade to play DRM-protected content.  

3. Click 'OK' in the dialog box. 
Windows Media Player opens and, the 'Security Upgrade Required' dialog 
box is displayed.  

4. Click 'OK' in the 'Security Upgrade Required' dialog box to perform the 
upgrade. 
The 'License Acquisition' dialog box is displayed, indicating that you 
have installed the Windows Media Player Security Upgrade.  

5. Click the 'Play' button in the 'License Acquisition' dialog box to complete 
the upgrade. 
Windows Media Player plays a brief file, confirming that you have 
completed the upgrade.  

6. Click the 'Cancel' button to close the 'License Acquisition' dialog box. If 
desired, you can also close Windows Media Player at this time. 



OverDrive Downloadable Audiobooks 
Birmingham Public Library 

 
FAQ, Guidelines and Requirements, & Questions To Ask 

 

Page 22 of  26  

You have successfully completed the Windows Media Player Security 
Upgrade.  

If you have Windows Media Player 11… 

1. While connected to the Internet, open OverDrive Media Console.  
2. Go to Tools > Windows Media Player Security Upgrade. 

A dialog box is displayed, notifying you that your Windows Media Player 
requires a security upgrade to play DRM-protected content.  

3. Click 'OK' in the dialog box. 
Windows Media Player opens and the 'Windows Media Player' dialog box 
is displayed.  

4. Click 'Upgrade' to download and install the required security 
component. 
Windows Media Player indicates that it is 'Connecting to server…'. Once 
connected, the security component is downloaded and installed. 
Windows Media Player indicates that the security component was 
upgraded successfully.  

5. Click the 'Close' button in the 'Windows Media Player' dialog box. 
The 'Media Usage Rights Acquisition' dialog box is displayed.  

6. Click the 'Play' button in the 'Media Usage Rights Acquisition' dialog box 
to complete the upgrade. 
Windows Media Player plays a brief file, confirming that you have 
completed the upgrade.  

7. Click the 'Cancel' button to close the 'License Acquisition' dialog box. If 
desired, you can also close Windows Media Player at this time. 
You have successfully completed the Windows Media Player Security 
Upgrade.  

If at a later time you need to upgrade the security of your Windows Media 
Player… 

If you have Windows Media Player 9 or 10… 

1. While connected to the Internet, open OverDrive Media Console.  
2. Go to Tools > Windows Media Player Security Upgrade. 

A dialog box is displayed, notifying you of your current Windows Media 
Player security version and offering the option to re-upgrade.  

3. To re-upgrade, click 'OK' in the dialog box. 
Windows Media Player opens, and the 'License Acquisition' dialog box is 
displayed.  

4. Click 'Play' in the 'License Acquisition' dialog box dialog box to perform 
the upgrade. 
The 'License Acquisition' dialog box closes, and Windows Media Player 
plays a brief file, confirming that you have completed the upgrade. If 
desired, you can close Windows Media Player at this time. 
You have successfully completed the Windows Media Player Security 
Upgrade.  
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If you have Windows Media Player 11… 

1. While connected to the Internet, open OverDrive Media Console.  
2. Go to Tools > Windows Media Player Security Upgrade. 

A dialog box is displayed, notifying you of your current Windows Media 
Player security version and offering the option to re-upgrade.  

3. To re-upgrade, click 'OK' in the dialog box. 
Windows Media Player opens, and the 'Media Usage Rights Acquisition' 
dialog box is displayed.  

4. Click 'Play' in the 'Media Usage Rights Acquisition' dialog box dialog box 
to perform the upgrade. 
The 'Media Usage Rights Acquisition' dialog box closes, and Windows 
Media Player plays a brief file, confirming that you have completed the 
upgrade. If desired, you can close Windows Media Player at this time. 
You have successfully completed the Windows Media Player Security 

Upgrade.  

General 
Why doesn't the eAudiobook download, even though I get an acquiring 
license message?  
 
See License and Windows Media Player. 

 
Why won't the eAudiobook play on my portable listening device? It played 
just fine yesterday.  
 
See Expired Checkout and Checked Out Items link, in the upper right-hand 
navigation of the Web site, to see if the eAudiobook checkout period has 
expired. 

 

Are audiobook files automatically removed from my computer when the 
checkout period expires?  
 
No. You need to manually delete the audiobook file from your personal 
computer and portable listening device. 

 

 
 
What if my download does not complete successfully?  
 
You might experience dropped connections for long downloads via dial up. You 
will need to restart your download if it does not complete.  
 
When I click on "Check Out & Download CD Quality" or "Check Out & 
Download Radio Quality" to download an eAudiobook I receive a C00D11CD, 
C00D1197 error or IE Web browser crashes.  
 
These errors occur when the Windows Media Player Media Bar has been 
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selected to play eAudiobooks from within the IE Web browser. With the media 
bar showing in the vertical Explorer Bar pane on the left-side of your Web 
browser window, click Media Option (bottom of the media bar), click Settings, 
and click the "Reset preferred types..." option. Answer "Yes" to "Do you want to 
reset your preferred media file types?" The next time you try to download an 
eAudiobook, this message displays: "You clicked an audio or video link. Internet 
Explorer can play this in its own window, so it will be easier for you to see or 
hear it while still browsing the Web. Do you want to play the item in Internet 
Explorer? Remember my preference Yes No More Info." The "Remember my 
preference" checkbox is the default. Click "No" and you are prompted to 
download the eAudiobook. 

Why did I get this message: "eAudiobooks: The Link You Clicked is No Longer 

Valid? (or something similar for OverDrive)"  

Audiobooks are protected by Digital Rights Management (DRM). Your computer's 

date/time clock settings must match the actual time zone, be set for the 

correct time of day, and must be as exact as possible. If the settings are off, 

DRM won't allow the download.  

Follow these steps to resolve the problem:  

1. Close any Internet Explorer windows that are open.  

2. Go to the Control Panel (click Start, Settings, and Control Panel) and 

click on the Date/Time icon to change the clock.  

3. Confirm that the date is set for the correct day of the week.  

4. Confirm that the clock is set to the correct hour and minute (don't 

worry about seconds).  

5. Confirm that the clock accurately reflects AM or PM depending on the 

time of day.  

6. Check the time zone setting and verify it is correctly set to your time 

zone.  

7. Click on Apply to save the changes and then click on OK to close the 

window.  

After all the clock settings have been adjusted, start Internet Explorer, go to 

the Web site, and try to download an audiobook. You should now be able to 

download the audiobook successfully 
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How long does it take to download an eAudiobook?    

 

Download Times (hours : minutes : seconds) 

Duration 
Quality  

 
File Size  Dial-up Modem 

56 Kbps  

DSL 256 

Kbps  

Cable Modem 

1.5 Mbps  

15 Hours CD Quality 217.8 MB 08:51:01  01:56:09  00:19:21  

10 Hours CD Quality 145.2 MB 05:54:00  01:17:26  00:12:54  

8 Hours CD Quality 116.16 MB 04:43:12  01:01:57  00:10:19  

5 Hours CD Quality 72.6 MB 02:57:00  00:38:43  00:06:27  

 
 

Terms / ”What is…?” 

What is an OverDrive Audio Book title? 

An OverDrive Audio Book title is a digitally-protected audio book that has been 
optimized for download. OverDrive Audio Book titles are built using the 
Microsoft® Windows Media Audio format, which greatly enhances the sound 
quality for desktop listening, play of CD copies (when allowed by the 
publisher), and portable device use.  

What is the OverDrive Media Console™? 

OverDrive Media Console is a free, fully integrated, and easy-to-use application 
that handles all aspects of your download audio book experience. 

With an intuitive interface, OverDrive Media Console allows you to download 
and enjoy OverDrive audio books on most Windows computers. Use OverDrive 
Media Console to navigate, play, and bookmark OverDrive media titles, and to 
manage and customize your media library. OverDrive Media Console includes a 
built-in Transfer Wizard that allows you to transfer titles to your supported 
portable player in just a few clicks. For audio books that may be burned to CD, 
OverDrive Media Console works with Windows Media Player to allow you to burn 
to CD without installing any extra software. 

What is a 'bit rate'? 

Bit rate is a measure of the quantity of audio data transferred from your 
device's memory to its audio decoder. Different devices support different 
ranges of bit rates. Some devices are able to convert unsupported bit rates to 
supported bit rates, a process called 'transcoding'. 
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